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概述

Siemens TCP/IP Server Ethernet驱动程序帮助 提供将 Siemens TCP/IP服务器设备连接到客户端应用程序

的可靠方式；其中包括 HMI、SCADA、Historian、MES、ERP和无数自定义应用程序。此驱动程序作为模拟

Siemens PLC 运行。适用于 Siemens S7-300 的模拟。
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设置

支持的协议
基于 TCP/IP的工业以太网 S7 报文通信协议 (ISO 8073 类 0)。这在 RFC1006 中进行了定义。

支持的命令
FB14-GET (S7-300)
FB15-PUT (S7-300)
SFB14-GET (S7-400)
SFB15-PUT (S7-400)

通道和设备限制
此驱动程序支持的最大通道数量为 1。此驱动程序所支持虚拟设备的最大数量为每通道 256 个。

存储库
此驱动程序需要标准以太网卡。不需要使用特殊的存储库或硬件。

注意：要与此驱动程序进行通信，需要在设备上使用专门的梯形图编程。

通道属性

设备属性

Siemens客户端设备配置

附录：使用 SIMATIC管理器配置连接
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通道属性 - 常规

此服务器支持同时使用多个通信驱动程序。服务器项目中使用的各个协议或驱动程序称为通道。服务器项

目可以由具有相同通信驱动程序或具有唯一通信驱动程序的多个通道组成。通道充当 OPC 链路的基础构建

块。此组用于指定常规通道属性，如标识属性和操作模式。

标识

“名称”：指定此通道的用户定义标识。在每个服务器项目中，每个通道名称都必须是唯一的。尽管名称最多可

包含 256 个字符，但在浏览 OPC 服务器的标记空间时，一些客户端应用程序的显示窗口可能不够大。通道

名称是 OPC 浏览器信息的一部分。该属性是创建通道所必需的。
有关保留字符的信息，请参阅服务器帮助中的“如何正确命名通道、设备、标记和标记组”。

“说明”：指定此通道的用户定义信息。

在这些属性中，有很多属性 (包括“说明”)具有关联的系统标记。

“驱动程序”：为该通道指定的协议 /驱动程序。指定在创建通道期间选择的设备驱动程序。它在通道属性中为

禁用设置。该属性是创建通道所必需的。
请知悉：服务器全天在线运行时，可以随时更改这些属性。其中包括更改通道名称以防止客户端向服务器

注册数据。如果客户端在通道名称更改之前已从服务器中获取了项，那么这些项不会受到任何影响。如果客

户端应用程序在通道名称更改之后发布项，并尝试通过原来的通道名称重新获取项，则该项将不被接受。一

旦开发完成大型客户端应用程序，就不应对属性进行任何更改。采用适当的用户角色和权限管理来防止操作

员更改属性或访问服务器功能。

诊断

“诊断数据捕获”︰启用此选项后，通道的诊断信息即可用于 OPC 应用程序。由于服务器的诊断功能所需的

开销处理量最少，因此建议在需要时使用这些功能，而在不需要时禁用这些功能。默认设置为禁用状态。
请知悉︰如果驱动程序不支持诊断，则该属性不可用。
有关详细信息，请参阅服务器帮助中的“通信诊断”。

诊断

“诊断数据捕获”：启用此选项后，将允许使用统计信息标记，用以向客户端应用程序提供有关通道操作的反

馈。由于服务器的诊断功能所需的开销处理量最少，因此建议在需要时使用这些功能，而在不需要时禁用这

些功能。默认设置为禁用状态。
请知悉︰如果驱动程序不支持诊断，则该属性不可用。
有关详细信息，请参阅服务器帮助中的“统计信息标记”。

标记计数

“静态标记”：提供此级别 (设备或通道)上已定义静态标记的总数。此信息有助于排除故障和平衡负载。

通道属性 - 以太网通信

以太网通信可用于与设备进行通信。
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以太网设置

“网络适配器”：指定要绑定的网络适配器。如果留空或选择“默认”，则操作系统将选择默认适配器。

通道属性 - 写入优化

服务器必须确保从客户端应用程序写入的数据能够准时发送到设备。为此，服务器提供了优化属性，用以满

足特定需求或提高应用程序响应能力。

写入优化

“优化方法”：控制如何将写入数据传递至底层通信驱动程序。选项包括：

l “写入所有标记的所有值”(Write All Values for All Tags)：此选项可强制服务器尝试将每个值均写入控

制器。在此模式下，服务器将持续收集写入请求并将它们添加到服务器的内部写入队列。服务器将对

写入队列进行处理并尝试通过将数据尽快写入设备来将其清空。此模式可确保从客户端应用程序写

入的所有数据均可发送至目标设备。如果写入操作顺序或写入项的内容必须且仅能显示于目标设备

上，则应选择此模式。

l “写入非布尔标记的最新值”︰由于将数据实际发送至设备需要一段时间，因此对同一个值的多次连续

写入会存留于写入队列中。如果服务器要更新已位于写入队列中的某个写入值，则需要大大减少写

入操作才能获得相同的最终输出值。这样一来，便不会再有额外的写入数据存留于服务器队列中。几

乎就在用户停止移动滑动开关时，设备中的值达到其正确值。根据此模式的规定，任何非布尔值都会

在服务器的内部写入队列中更新，并在下一个可能的时机发送至设备。这可以大大提高应用性能。

注意︰该选项不会尝试优化布尔值的写入。它允许用户在不影响布尔运算的情况下优化 HMI数据

的操作，例如瞬时型按钮等。

l “写入所有标记的最新值”︰该选项采用的是第二优化模式背后的理论并将其应用至所有标记。如果应

用程序只需向设备发送最新值，则该选项尤为适用。此模式会通过在当前写入队列中的标记发送前

对其进行更新来优化所有的写入操作。此为默认模式。

“占空比”(Duty Cycle)︰用于控制写操作与读操作的比率。该比率始终基于每一到十次写入操作对应一次读

取操作。占空比的默认设置为 10，这意味着每次读取操作对应十次写入操作。即使在应用程序执行大量的

连续写入操作时，也必须确保足够的读取数据处理时间。如果将占空比设置为 1，则每次读取操作对应一次

写入操作。如果未执行任何写入操作，则会连续处理读取操作。相对于更加均衡的读写数据流而言，该特点

使得应用程序的优化可通过连续的写入操作来实现。
注意︰建议在将应用程序投入生产环境前使其与写入优化增强功能相兼容。

通道属性 - 高级

此组用于指定高级通道属性。并非所有驱动程序都支持所有属性，因此不会针对不支持的设备显示“高级”
组。
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“非规范浮点数处理”：非规范值定义为无穷大、非数字(NaN)或非规范数。默认值为“替换为零”。具有原生浮

点数处理功能的驱动程序可能会默认设置为“未修改”。通过非规范浮点数处理，用户可以指定驱动程序处理

非规范 IEEE-754 浮点数据的方式。选项说明如下：

l “替换为零”：此选项允许驱动程序在将非规范 IEEE-754 浮点值传输到客户端之前，将其替换为零。

l “未修改”：此选项允许驱动程序向客户端传输 IEEE-754 非规范、规范、非数字和无穷大值，而不进行

任何转换或更改。

注意：如果驱动程序不支持浮点值或仅支持所显示的选项，则将禁用此属性。根据通道的浮点规范设置，

将仅对实时驱动程序标记 (如值和数组)进行浮点规范。例如，此设置不会影响 EFM数据。

有关浮点值的详细信息，请参阅服务器帮助中的“如何使用非规范浮点值”。

“设备间延迟”：指定在接收到同一通道上的当前设备发出的数据后，通信通道向下一设备发送新请求前等待

的时间。设置为零 (0)将禁用延迟。

注意：此属性并不适用于所有驱动程序、型号和相关设置。

通道属性 - 通信属性

“端口号”：指定驱动程序监听的端口号。必须将设备配置为连接此端口：发送到所有其他端口的消息都将被

驱动程序忽略。有效范围为 0 到 65535。默认设置为 TCP/IP：102 (TSAP)。
注意︰路由和防火墙问题可能需要使用非标准值。

www.ptc.com
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设备属性 - 常规

一个设备代表通信通道上的单一目标。如果驱动程序支持多个控制器，则用户必须为每个控制器输入一个

设备 ID。

标识

“名称”：指定设备的名称。此为用户定义的逻辑名称，最长可达 256 个字符，并且可以用于多个通道。

注意：尽管描述性名称通常是不错的选择，但浏览 OPC 服务器的标记空间时，一些 OPC 客户端应用程序

的显示窗口可能不够大。设备名称和通道名称也成为浏览树信息的一部分。OPC 客户端中，通道名称和设备

名称的组合将显示为“通道名称 .设备名称”。
有关详细信息，请参阅服务器帮助中的“如何为通道、设备、标记和标记组正确命名”。

“说明”：指定此设备的用户定义信息。

在这些属性中，有很多属性 (包括“说明”)具有关联的系统标记。

“通道分配”：指定该设备当前所属通道的用户定义名称。

驱动程序：为该设备选择的协议驱动程序。

“型号”：指定与此 ID 关联的设备的类型。下拉菜单中的内容取决于正在使用的通信驱动程序类型。驱动程序

不支持的型号将被禁用。如果通信驱动程序支持多个设备型号，则只有当设备未与任何客户端应用程序连

接时，才能改变型号的选择。
注意：如果通信驱动程序支持多种型号，则用户应将型号选择与物理设备进行匹配。如果下拉列表菜单中

未显示该设备，则选择与目标设备最相近的型号。一些驱动程序支持名为“开放式”的型号选择，该选择使用

户无需了解目标设备的具体信息即可进行通信。有关详细信息，请参阅驱动程序文档。

ID：指定设备驱动程序特定的工作站或节点。输入的 ID 类型取决于正在使用的通信驱动程序。对于许多通信

驱动程序而言，ID 是一个数值。支持数字 ID 的驱动程序使用户能够输入格式可更改的数值，以适应应用程

需要或所选通信驱动程序特点。默认情况下，该格式由驱动程序设置。选项包括十进制、八进制和十六进

制。
注意：如果驱动程序基于以太网，或者支持非常规工作站或节点名称，则可使用设备的 TCP/IP地址作为

设备 ID。TCP/IP地址包含四个由句点分隔的值，每个值的范围在 0 至 255 之间。某些设备 ID 基于字符串。

根据不同驱动程序，也可以在 ID 字段中配置其他属性。

操作模式

数据收集：此属性控制设备的活动状态。尽管默认情况下会启用设备通信，但可使用此属性禁用物理设备。

设备处于禁用状态时，不会尝试进行通信。从客户端的角度来看，数据将标记为无效，且不接受写入操作。

通过此属性或设备系统标记可随时更改此属性。

“模拟”：使设备进入或退出模拟模式。在此模式下，驱动程序不会尝试与物理设备进行通信，但服务器将继续

返回有效的 OPC 数据。模拟停止与设备的物理通信，但允许 OPC 数据作为有效数据返回到 OPC 客户端。

www.ptc.com
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在“模拟模式”下，服务器将所有设备数据处理为反射型：无论向模拟设备写入什么内容，都会读取回来，而且

会单独处理每个 OPC 项。如果服务器移除了项 (如服务器重新初始化时)，则不保存数据。默认值为“否”。

请知悉：
1. 只有当客户端断开连接并重新连接后，才会应用更新。

2. “系统”标记 (_Simulated)为只读且无法写入，从而达到运行时保护的目的。“系统”标记允许从客户端监控此

属性。

3. 在“模拟”模式下，项的内存映射取决于客户端更新速率 (OPC 客户端的“组更新速率”或本机和 DDE接口的

扫描速率)。这意味着，参考相同项、而采用不同更新速率的两个客户端会返回不同的数据。

4. 模拟设备时，客户端的更新速度可能不会低于 1 秒。

“模拟模式”仅用于测试和模拟目的。该模式永远不能用于生产环境。

标记计数

“静态标记”：提供此级别 (设备或通道)上已定义静态标记的总数。此信息有助于排除故障和平衡负载。

设备属性 - 扫描模式

“扫描模式”为需要设备通信的标记指定订阅客户端请求的扫描速率。同步和异步设备的读取和写入会尽快处

理；不受“扫描模式”属性的影响。

“扫描模式”：为发送到订阅客户端的更新指定在设备中扫描标记的方式。选项说明如下：

l “遵循客户端指定的扫描速率”：此模式可使用客户端请求的扫描速率。
l “不超过扫描速率请求数据”：此模式可将该数值集指定为最大扫描速率。有效范围为 10 至 99999990

毫秒。默认值为 1000 毫秒。

注意：当服务器有活动的客户端和设备项且扫描速率值有所提高时，更改会立即生效。当扫描速率

值减小时，只有所有客户端应用程序都断开连接，更改才会生效。

l “以扫描速率请求所有数据”：此模式将以订阅客户端的指定速率强制扫描标记。有效范围为 10 至

99999990 毫秒。默认值为 1000 毫秒。

l “不扫描，仅按需求轮询”：此模式不会定期轮询属于设备的标签，也不会在一个项变为活动状态后为

获得项的初始值而执行读取操作。OPC 客户端负责轮询以便更新，方法为写入 _DemandPoll 标记或

为各项发出显式设备读取。有关详细信息，请参阅服务器帮助中的“设备需求轮询”。
l “遵循标签指定的扫描速率”：此模式将以静态配置标记属性中指定的速率强制扫描静态标记。以客户

端指定的扫描速率扫描动态标记。

“来自缓存的初始更新”：启用后，此选项允许服务器为存储 (缓存)数据的新激活标签参考提供第一批更新。

只有新项参考共用相同的地址、扫描速率、数据类型、客户端访问和缩放属性时，才能提供缓存更新。设备

读取仅用于第一个客户端参考的初始更新。默认设置为禁用；只要客户端激活标记参考，服务器就会尝试从

设备读取初始值。

设备属性 - CPU 设置
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“机架编号”：此属性用于指定相关模拟 CPU 所在机架的编号。有效范围为 0 到 7。设备必须具有唯一的机架

和插槽值。默认设置为 0。

“CPU 槽”：此属性用于指定相关模拟 CPU 所在插槽的编号。有效范围为 0 到 31。设备必须具有唯一的机架

和插槽值。默认设置为 0。

“PDU 大小上限”：此属性用于指定驱动程序支持的协议数据单元的最大大小。可将其配置为 240、480 和 960
个字节。

注意：要查看与设备协商的 PDU 值，请使用 _CurrentPDUSize 内部标记 (参阅内部标记)。

www.ptc.com
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Siemens客户端设备配置

必须对 Siemens PLC 进行编程，以便向驱动程序发出读写命令并处理返回的数据。有关详细信息，请参阅
Siemens PLC 编程文档。有关准备 Siemens客户端设备和非主动请求驱动程序进行通信的信息，请参阅使
用 SIMATIC 管理器配置连接。

必须将消息发送到运行非主动请求驱动程序的主机中的选定以太网适配器的 IP地址。要执行此操作，请更

新通道属性。
有关为模拟设备配置的端口号的详细信息，请参阅通信属性。

内部标记

尽管以下内部标记在服务器配置中不可见，但可通过 OPC 客户端进行浏览，并在 <通道名称>下找到。<设
备名称>._InternalTags组。如果 OPC 客户端不支持浏览，或者正在使用非 OPC 客户端，可以通过下面给出

的地址以动态方式或静态方式创建这些标记。

设备地址 说明 范围
数据

类型

访

问

_
CurrentPDUSize

连接后，此标记显示与设备协商的协议数据单元大小。在连接之

前，它显示已配置的最大 PDU 值。

240,
480,
960

字 读

取

www.ptc.com
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数据类型说明

数据类型 说明

布尔型 单个位

字节 无符号 8 位值

字符 有符号 8 位值

字 无符号 16 位值

位 0 是低位

位 15 是高位

短整型 有符号 16 位值

位 0 是低位

位 14 是高位

位 15 是符号位

双字 无符号 32 位值

位 0 是低位

位 31 是高位

长整型 有符号 32 位值

位 0 是低位

位 30 是高位

位 31 是符号位

BCD 两个字节封装的 BCD
值的范围是 0 至 9999。对于超出此范围的值，未定义行为。

LBCD 四个字节封装的 BCD
值的范围是 0 至 99999999。对于超出此范围的值，未定义行为。

浮点型 32 位浮点值。

驱动程序将两个连续寄存器解释为浮点值，方法是将第二个寄存器作为高位字，将第一

个寄存器作为低位字。

字符串 空终止 ASCII字符串

www.ptc.com
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地址说明

以下信息适用于 S7-300 和 S7-400 型号。动态定义标记的默认数据类型以粗体显示。

地址类型 范围 类型 访问

离散输入 I0.b-I4095.b*
.b 为位数 0-7

IB0-IB4095
IW0-IW4094
IW:KT0-IW:KT4094
IW:KC0-IW:KC4094
ID0-ID4092

布尔型

字节、字符、字符串**
字、短整型、BCD
双字、长整型

字、短整型

双字、长整型、LBCD、浮点型

读 /写

读 /写
读 /写
读 /写
读 /写
读 /写

离散输入

注意：I和 E访问相同

的内存区域。

E0.b-E4095.b*
.b 为位数 0-7

EB0-EB4095**
EW0-EW4094
EW:KT0-EW:KT4094
EW:KC0-EW:KC4094
ED0-ED4092

布尔型

字节、字符、字符串**
字、短整型、BCD
双字、长整型

字、短整型

双字、长整型、LBCD、浮点型

读 /写

读 /写
读 /写
读 /写
读 /写
读 /写

离散输出 Q0.b-Q4095.b*
.b 为位数 0-7

QB0-QB4095
QW0-QW4094
QW:KT0-QW:KT4094
QW:KC0-QW:KC4094
QD0-QD4092

布尔型

字节、字符、字符串**
字、短整型、BCD
双字、长整型

字、短整型

双字、长整型、LBCD、浮点型

读 /写

读 /写
读 /写
读 /写
读 /写
读 /写

离散输出

注意：Q和 A访问相同

的内存区域。

A0.b- A4095.b*
.b 为位数 0-7

AB0-AB4095
AW0-AW4094
AW:KT0-AW:KT4094
AW:KC0-AW:KC4094
AD0-AD4092

布尔型

字节、字符、字符串**
字、短整型、BCD
双字、长整型

字、短整型

双字、长整型、LBCD、浮点型

读 /写

读 /写
读 /写
读 /写
读 /写
读 /写

内存 F0.b-F4095.b*
.b 为位数 0-7

FB0-FB4095
FW0-FW4094
FW:KT0-FW:KT4094
FW:KC0-FW:KC4094
FD0-FD4092

布尔型

字节、字符、字符串**
字、短整型、BCD
双字、长整型

字、短整型

双字、长整型、LBCD、浮点型

读 /写

读 /写
读 /写
读 /写
读 /写
读 /写

内部内存

注意：F和 M访问相同

的内存区域。

M0.b-M4095.b*
.b 为位数 0-7

MB0-MB4095
MW0-MW4094
MW:KT0-MW:KT4094

布尔型

字节、字符、字符串**
字、短整型、BCD
双字、长整型

字、短整型

读 /写

读 /写
读 /写
读 /写
读 /写

www.ptc.com
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地址类型 范围 类型 访问

MW:KC0-MW:KC4094
MD0- MD4092

双字、长整型、LBCD、浮点型 读 /写

数据块布尔值 DB1-N:KM0.b-KM4094.b*
1-N 为块编号

.b 为位数 0-15

替换

DB1DBX0.b-DBNDBX4094.b*
1-N 为块编号

.b 为位数 0-15

DB1D0.b-DBND4094.b*
1-N 为块编号

.b 为位数 0-15

布尔型

布尔型

布尔型

读 /写

读 /写

读 /写

数据块左字节 DB1-N:KL0-KL4095
1-N 为块编号

替换

DB1DBB0-DBNDBB4095
1-N 为块编号

DB1DL0-DBNDL4095
1-N 为块编号

字节、字符、字符串**

字节、字符、字符串**

字节、字符、字符串**

读 /写

读 /写

读 /写

数据块右字节 DB1-N:KR0-KR4094
1-N 为块编号

替换

DB1DR0-DBNDR4094
1-N 为块编号

字节、字符、字符串**

字节、字符、字符串**

读 /写

读 /写

数据块 无符号字 DB1-N:KH0-KH4094
1-N 为块编号

字、短整型、BCD 读 /写

数据块 有符号字 DB1-N:KF0-KF4094
1-N 为块编号

替换

DB1DBW0-DBNDBW4094
1-N 为块编号

DB1DW0-DBNDW4094
1-N 为块编号

字、短整型、BCD

字、短整型、BCD

字、短整型、BCD

读 /写

读 /写

读 /写

数据块有符号长整型值 DB1-N:KD0-KD4092
1-N 为块编号

替换

DB1DBD0-DB1DBD4092
1-N 为块编号

DB1DD0-DB1DD4092
1-N 为块编号

双字、长整型、LBCD、浮点型

双字、长整型、LBCD、浮点型

双字、长整型、LBCD、浮点型

读 /写

读 /写

读 /写
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地址类型 范围 类型 访问

数据块 浮点型 DB1-N:KG0-KG4092
1-N 为块编号

浮点型 读 /写

数据块 BCD DB1-N:BCD0-BCD4094
1-N 为块编号

字、短整型 读 /写

数据块 S5 计时器作为

DB
DB1-N:KT0-KT4094
1-N 为块编号

双字、长整型 读 /写

数据块 S5 计数器作为

DB
DB1-N:KC0-KC4094
1-N 为块编号

字、短整型 读 /写

数据块 字符串 DB1:S0.n-DB1:S4095.n*
.n 是字符串长度

0<n<= 932

字符串 读 /写

*这些内存类型 /子类型不支持数组。
**字节内存类型 (MB)支持字符串。字符串语法为 <地址>.<长度>，其中 0 <长度 <= 932。

注意：

1. 内存类型 I、Q和 F的所有偏移均表示指定内存类型范围内的字节起始位置。

2. 修改字型、短整型、双字和长整型时请小心。对于 I、Q和 F，每个地址在设备内的字节偏移处开始。

因此，字 FW0 和 FW1 在字节 1 处重叠。写入 FW0 时会修改保存在 FW1 中的值。同样，双字和长整

型也会重叠。建议使用这些内存类型，以避免发生重叠。例如，在使用双字时，应使用 FD0、FD4、
FD8 等以防止字节重叠。

3. 对于字符串，请求的字节总数不能超过协商 PDU 大小的数据部分。超过协商 PDU 大小的原始字符

串可能无法读写。

数组
所有内存类型 /子类型均支持数组 (上述类型除外)。用于声明数组的有效语法如下所示。如果未指定行数，则

假定行数为 1。

<地址>[行数 ][列数 ]
<地址>.行数 .列数
<地址>,行数 ,列数
<地址>_行数_列数

对于字、短整型、BCD 和 "KT"数组，基址+(行数*列数*2)不能超过 4096。数组的元素是位于字边界上的字。

例如，IW0[4]将返回 IW0、IW2、IW4 和 IW6。由于存储在 PLC 中的数据包含在一个字内，因此 "KT"子类型属

于 16 位类别。

对于浮点型、双字、长整型和长 BCD 数组 (不包括 "KT"子类型)，基址+(行数*列数*4)不能超过 4096。请注

意，数组的元素是位于双字边界上的双字。例如 , ID0[4]返回 ID0、ID4、ID8 和 ID12。

对于所有数组，请求的字节总数不能超过协商 PDU 大小的数据部分。例如，对于 960 字节 PDU 大小，可读

写的最大单个数组是 932 字节。

KL、KR、DBB 比较
KL 和 KR 确定数据块字返回的是左字节还是右字节。

值 8 9 A B C

字节 0 1 2 3 4

示例 1
DB1:KH0=0x89
DB1:KL0=0x8
DB1:KR0=0x9
DB1DBB0=0x8
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示例 2
DB1:KH1=0x9A
DB1:KL1=0x9
DB1:KR1=0xA
DB1DBB1=0x9

示例

l 要访问内部内存 F20 的位 3，请按如下所示声明地址：F20.3
l 要以字内存访问数据块 5 的字节 30，请声明地址：DB5:KH30
l 要访问数据块 2 的字节 20 和位 7，请声明地址：DB2:KM20.7
l 要以左字节内存访问数据块 1 的字节 10，请声明地址：DB1:KL10
l 要以双字访问内存 F20，请声明地址：FD20
l 要以字访问输入内存 I10，请声明地址：IW10
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15



Siemens TCP/IP Server Ethernet驱动程序帮助

事件日志消息

以下信息涉及发布到主要用户界面中“事件日志”窗格的消息。。关于如何筛选和排序“事件日志”详细信息视

图，请参阅 OPC 服务器帮助。服务器帮助包含许多常见的消息，因此也应对其进行搜索。通常，其中会尽可

能提供消息的类型 (信息、警告)和故障排除信息。

无法启动非主动请求通信。|端口号 = <数字>。
错误类型：
错误

可能的原因：

1. 驱动程序无法为非主动请求通信创建侦听套接字。其他应用程序可能正在使用指定端口。

2. 系统资源可能不足。

可能的解决方案：

1. 使用网络监视软件查看是否有其他应用程序正在使用该端口。如果有，请关闭冲突的应用程序，然后

重新启动 OPC 服务器。如果冲突的应用程序可自由选择任意可用的端口，请确保始终首先启动该服

务器，以使它能请求所需端口。如果 PLC 编程软件和此驱动程序均必须使用同一端口，则它们可能

无法同时使用。

2. 验证系统资源是否充足或从其他进程释放资源。

也可以看看：
通道设置

www.ptc.com
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Appendix: Configuring Connections Using the
SIMATIC Manager
Connections are configured using the SIMATIC Manager software. The following topics provide information on
configuring the Siemens TCP/IP Server Ethernet驱动程序帮助 to run in unsolicited mode, and demonstrate a
basic setup using the S7-300 PLC as the active partner and the driver as the passive partner.

Note: The Siemens TCP/IP Server Ethernet驱动程序帮助can configure 256 devices, each with an
associated slot/rack. When the active partner (Siemens client) communicates with the passive partner
(unsolicited or Siemens server driver), it directs its requests to a specific device in the unsolicited driver.
Multiple remote partners can talk to the same device.

To jump to a specific section, select a link from the list below.

Step One: Creating a New Project
Step Two: Configuring the Siemens Client and PC Station
Step Three: Connecting the Siemens Client and the Siemens Server Driver
Step Four: Inserting Function Blocks
Step Five: Creating the DB3 Data Block
Step Six: Inserting PUT FB
Step Seven: Downloading to the PLC

Step One: Creating a New Project

1. To start, open the SIMATIC Manager software and then create a new project. In this example, the project
being used is "Setup".
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2. Create the Siemens client and PC Station. To do so, right-click in the right pane of the window and then
select Insert New Object | SIMATIC 300 Station.

Tip: The Siemens client unit is the active partner or the image of the actual PC. The PC Station is the
PC on which the SIMATIC Manager software is running.

3. Name the new station "SIEMENS-CLIENT" because it represents the communication's active partner.
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4. Right-click in the right pane of the window and select Insert New Object | SIMATIC PC Station.

 For more information, refer to Step Two: Configuring the Siemens Client and PC Station.

Step Two: Configuring the Siemens Client and PC Station
Industrial Ethernet (IE) is the protocol used for communication.

1. To start, right-click in the right pane of the SIMATIC Manager window. Select Insert New Object |
Industrial Ethernet.

www.ptc.com
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2. Select the SIEMENS CLIENT icon in the left pane of the window and double-click Hardware.
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3. Open the View tab and select Catalog.

4. Expand the SIMATIC 300 menu and the Rack 300 menu.
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5. To insert the racks, double-click on Rail.

6. Expand the PS 300 menu. Double-click on PS 307 10A or any other suitable option to insert the power
supply into slot 1.
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7. To insert the CPU, expand both the CPU 300 menu and the CPU 315-2 DP menu.
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8. Double-click on the CPU that matches the hardware.
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9. To insert the CPU into slot 2, click OK.

10. To insert the CP, leave slot 3 empty and then click on slot 4 in the racks.

11. Expand both the CP 300 menu and the Industrial Ethernet menu.

12. Double-click on the CP that matches the hardware.
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13. Enter the PLC's IP address and subnet mask. Select Ethernet from the subnet box.

www.ptc.com

27



Siemens TCP/IP Server Ethernet驱动程序帮助

14. Click OK to configure the Siemens client.

15. Once finished, open the View tab and select Catalog to hide the catalog window.

16. Save and exit the HWConfiguration window.

17. To configure the PC station, click on the SIMATIC PC Station in the left pane of the SIMATIC Manager
window.

18. Double-click on Configuration.
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19. Click on the View tab and select Catalog.

20. Expand both the SIMATIC PC Station menu and the CP Industrial Ethernet menu.

21. Double-click on General or any other suitable option.
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22. Enter the IP address of the PC running the SIMATIC Manager software, in addition to the correct subnet
mask.

23. Select Ethernet from the subnet box.
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24. Click OK to configure the PC station.

25. Once finished, open the View tab and select Catalog to hide the catalog window.

26. Save and exit the HWConfiguration window.

For more information, refer to Step Three: Connecting the Client and the Server Driver.

Step Three: Connecting the Siemens Client and the Siemens Server Driver
Once the Siemens client and the PC Station have been successfully configured, the Siemens client and the
Siemens server must be connected.

1. To start, open the Options tab in the SIMATIC Manager window and select Configure Network.
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2. Click on the Siemens client's CPU 315-2 DP block. A series of rows should be displayed in the lower
half of the window.
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3. Right-click on the first row and select Insert New Connection.

4. Click OK.
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5. Enter the IP address of the machine on which the Siemens TCP/IP Server Ethernet驱动程序帮助 runs.

6. Click Address Details and enter the rack/slot values of the device in the unsolicited driver with which the
Siemens client should communicate.

7. Click OK twice to successfully connect the Siemens client and server drivers. The Siemens client uses
these settings to communicate with the destination device at rack 0 and slot 2.
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Note: The Local ID number (=1) identifies the connection between the two partners. This number is
used later when creating function blocks for reading and writing data.

8. Save and compile the data by opening the Network tab and selecting Save and Compile. Click OK.

Note: There should be no errors on compilation.

For more information, refer to Step Four: Inserting Function Blocks.

Step Four: Inserting Function Blocks
Once the Siemens client has been configured and connected with the Siemens server or unsolicited driver, it
must also be prepared to generate requests for the unsolicited partner. This is done by creating function blocks,
which can be used to read data from or write data to an unsolicited driver. The function block (FB) used for
reading data in this example is FB14 (GET). The function block (FB) for writing data is FB15 (PUT).
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1. Expand the Siemens client menu, the CPU 315-2 DP menu, and the S7 Program[1] menu.

2. Double-click on Blocks and OB1.

3. LAD, STL, or FBD can be used to create function blocks. In this example, FBD is used. In the
LAD/STL/FBD window, click on the Insert menu.
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4. Click Program Elements.

5. Expand the Libraries, SIMATIC_NET_CP, and CP 300 menus.
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6. Double-click on FB14 GET to insert a function block to read data.
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7. Close the Program Elements window. "FB14" should be inserted as shown below.

8. Associate a data block (DB) with the function block (FB). To do so, click above the FB where there are
three red question marks.
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9. Enter the name of a data block. In this example, it is "DB2".

10. Click Yes to create the data block.

11. Fill in the other details as appropriate for the fields in the function block. Users should consider the
following:

l "ADDR_1" is the address on the destination device in the unsolicited driver.

l "RD_1" is the address local to the PLC.

l The value at the remote address specified by "ADDR_1" is written (GET) to the local address
specified by "RD_1".

l Enter the Local ID number that was generated when setting up the connection between the
Siemens client and the Siemens server driver in the ID field. In this example, the Local ID
number is 1.
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The number of bytes in both the "ADDR_1" and "RD_1" fields should be same for the
unsolicited driver to respond correctly. Otherwise, an error occurs.

Note: Now that the GET function block has been created successfully, users must remember that the
block gets executed / triggered only on a rising edge (REQ).

12. Click Save and close the LAD/STL/FBD window.

For more information, refer to Step Five: Creating the DB3 Data Block.

Step Five: Creating the DB3 Data Block
While configuring GET FB, the data block "DB3" was used for the "RD_1" field. This is the data block that stores
read values.

1. Right-click in the right pane of the SIMATIC Manager window and then select Insert New Object| Data
Block.
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2. Change the name to "DB3."
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3. Double-click on DB3. To assign some memory to the data block, users can make changes similar to
those shown below. Although the array size in this example is arbitrary, values should be specified to fit
a particular need.

4. Save and close the LAD/STL/FBD window.

For more information, refer to Step Six: Inserting PUT FB.

Step Six: Inserting PUT FB

1. Create a separate data block for the PUT FB, which holds the data that is written to the remote partner.
To insert this new data block, follow the steps in Step Five: Creating the DB3 Data Block but name it
"DB5."

2. Double-click on DB5, then specify a memory size. Although the array size in this example was chosen
arbitrarily, the values should be specified to fit a particular need.

www.ptc.com

45



Siemens TCP/IP Server Ethernet驱动程序帮助

3. To insert the PUT FB, double-click on OB1 in the SIMATIC Manager window.

4. In LAD/STL/FBD, right-click in the blank space below GET FB.
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5. Click Insert Network and select the blank space below.

6. Click Insert | Program Elements.

7. Expand the Libraries, SIMATIC_NET_CP, and CP 300 menus.

8. To insert a function block to write data, double-click on FB15 PUT.
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9. Close the Program Elements window.

10. Associate a data block (DB) with the function block (FB). To do so, click above the FB where there are
three red question marks.

11. Specify a name. In this example, "DB4" is used.

12. A window prompt requests confirmation of data block creation. Click Yes.

13. Fill in the other details as appropriate. Users should consider the following:

l "ADDR_1" address is on the destination device in the unsolicited driver.

l "SD_1" is the address local to the PLC.

l The value at the local address specified by "SD_1" is written (PUT) to the remote address
specified by "ADDR_1".

l Enter the Local ID number that was generated when setting up the connection between the
Siemens client and the Siemens server driver in the ID field. In this example, the Local ID
number is 1.

Important: The number of bytes in both the "ADDR_1" and "SD_1" fields should be same for
the unsolicited driver to respond correctly. Otherwise, an error occurs.
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14. Click Save and close LAD/STL/FBD.

For more information, refer to Step Seven: Downloading to the PLC.

Step Seven: Downloading to the PLC
Once the Siemens client has been prepared to generate Read / Write requests for the remote unsolicited
partner, the information must be downloaded to the PLC.
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1. Click Siemens client in the left pane of the SIMATIC Manager window.

2. Select the PLC menu.

3. Select Download to begin downloading the project to the PLC.

4. Click OK.

5. Click Yes.

Note: The Siemens client must be run to trigger the function blocks that generate Read / Write
requests.
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6. Double-click on OB1 in the SIMATIC Manager window.

7. In LAD/STL/FBD, click Debug | Monitor.

Note: LAD/STL/FBD should appear in Online Mode.
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8. To execute GET/PUT FBs, change the REQ value to 0 and then 1 to indicate the rising edge. To do so,
right-click on the REQ field and select Modify to 0 to force a zero to the field.
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9. Right-click on the REQ field and select Modify to 1 to force a value of one to the field.
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Note: Both of the FBs must next be configured to respond to the same rising edge for the SIMATIC
Manager's variables to be locally monitored and modified.

10. In LAD/STL/FBD, click on PLC and select Monitor/Modify Variables.

11. Enter the variables to be monitored. To view the changes made to this window, execute the function
blocks.
Note: Remember that the slot / rack value of the remote device with which the Siemens client is

communicating is "rack:0 slot:2". The values can be changed from the NetPro window. Users must make
sure that the Siemens server or unsolicited driver on the other end has a device with these values and is
running.
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